Release Notes for Nuke and Hiero 11.3v6

Copyright © 2019 The Foundry Visionmongers Ltd.

Release Date

08 November 2019

Qualified Operating Systems

• macOS High Sierra (10.13) or macOS Mojave (10.14)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

Note: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don’t have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

**Note:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

**AMD**

**Note:** Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

**Note:** Other AMD GPUs may work, but have not been fully tested.

• On Mac, AMD GPUs are supported on any Mac Pro running Mac OS X Mavericks (10.9.3), mid 2015 MacBook Pros onward, and late 2017 iMac Pros.

**Warning:** Although AMD GPUs are enabled on Mac Pros manufactured prior to the late 2013 model, they are not officially supported and used at your own risk.

**Multi-GPU Processing**

Nuke’s GPU support includes an **Enable multi-GPU support** option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.
New Features

There are no new features in this release.

Feature Enhancements

There are no new feature enhancements in this release.

Bug Fixes

- BUG ID 347416 - Deep: Writing output containing Deep data using the standard Write node caused Nuke to crash.
- BUG ID 352422 - Read/Write: Importing a previously exported .mov clip displayed a PAL format warning.
- BUG ID 352820 - Node Graph: Copying and pasting nodes duplicated any user knobs in the copies.
- BUG ID 357332 - Expressions: Rendering a script from the command line using expressions containing `channels()` (Python) or `layers` (Tcl) did not work as expected.
- BUG ID 385582 - Timeline Multi-View: Rendering multi-view comps in new projects did not work as expected.
- BUG ID 391897 - Soft Effects: Copying and pasting effects did not work as expected after reopening a Nuke Studio project.
- BUG ID 394039 - DeepHoldout produced incorrect results when deep pixels intersected.
- BUG ID 399879 - ARRI ADA-5: The fine-tuning controls was missing from the node Properties panel.
- BUG ID 399908 - Deep: Using DeepRecolor with `target input alpha` enabled on a single channel created artifacts in the other channels.
- BUG ID 402361 - OCIO: All LUTs from config files were loaded, even if they were not used, causing Nuke to start up more slowly.
- BUG ID 409069 - Deep: Using DeepRecolor with `target input alpha` enabled on all channels removed deep samples incorrectly.
- BUG ID 409739 - QuickTime: Files rendered using the mov32 encoder did not export nclc data correctly.

New Known Issues Specific to Nuke 11.3

This section covers new known issues and gives workarounds for them, where appropriate.
• BUG ID 396084 - OCIO Roles: Reconnecting media sets the clip colorspace to " " and displays an error in the Viewer.
   As a workaround, select a different colorspace and then switch back to required colorspace to clear the error.
• BUG ID 392942 - macOS only: The out of range warnings are currently always active in Nuke’s scopes.
• BUG ID 374580 - Linux only: Switching between workspaces with OpenGL Stereo and other modes active in the Viewer occasionally causes Nuke Studio to crash.
• BUG ID 366048 - Linux only: Heavy Particles simulations occasionally display the OS not responding error dialog.
• BUG ID 413755 - Windows only: The NDK examples Makefile does not compile as expected.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/113/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>11.0v1 to 11.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>11.0v1 to 11.2v1</td>
<td>API</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Additionally, node **Class()** names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The `toolbars.py` file, used to create Nuke’s node toolbar, contains all the current node class names and is located in `<install_directory>/plugins/nukescripts/` for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node **Class()** changed from CameraShake2 to CameraShake3. In the `toolbars.py` file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

- **BUG ID 393974 - Python:** A new method, `Node.parent()`, has been added to return a GroupNode Python object for the current parent Group.
Bug Fixes

- BUG ID 377366 - Linux and OSX only: The NDK examples **Makefile** did not compile as expected.
Release Notes for Nuke and Hiero 11.3v5

Copyright © 2019 The Foundry Visionmongers Ltd.

Release Date

01 August 2019

Qualified Operating Systems

• macOS High Sierra (10.13) or macOS Mojave (10.14)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

Note: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don’t have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

Note: Other AMD GPUs may work, but have not been fully tested.

• On Mac, AMD GPUs are supported on any Mac Pro running Mac OS X Mavericks (10.9.3), mid 2015 MacBook Pros onward, and late 2017 iMac Pros.

Warning: Although AMD GPUs are enabled on Mac Pros manufactured prior to the late 2013 model, they are not officially supported and used at your own risk.

Multi-GPU Processing

Nuke’s GPU support includes an Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.
New Features

There are no new features in this release.

Feature Enhancements

There are no new feature enhancements in this release.

Bug Fixes

- BUG ID 158765 - DeepRecolor: Enabling `target input alpha` flattened Deep channels that should not be affected.
- BUG ID 242922 - Timeline Editing: Using the Slip tool in sequences with multiple tracks in the Viewer occasionally caused Nuke Studio to become unresponsive.
- BUG ID 335191 - Read/Write: The Advanced > `write ncic` control in the Write node's Properties panel did not work as expected with `.mov` files written using the Apple ProRes 4444 codec.
- BUG ID 336130 - The Viewer interface in Fullscreen mode on a second monitor occasionally became unresponsive.
- BUG ID 347416 - Deep: Writing output containing Deep data using the standard Write node caused Nuke to crash.
- BUG ID 349303 - Text: Changing the `opacity` of text shifted the output to the left and created artifacts in the Viewer.
- BUG ID 350840 - Linux only: Labels in the Node Graph became unreadable at certain zoom levels.
- BUG ID 362521 - Roto/RotoPaint: The tooltip for adjusting B-spline tension in the Properties panel ? button was incorrect.
- BUG ID 369379 - Windows only: Attempting to select points outside the 3D Viewer window using the Ellipse selection tool caused Nuke to crash.
- BUG ID 378932 - Running stereo scripts containing nodes in an error state in terminal mode with the `continueOnError=False` argument rendered frames incorrectly.
- BUG ID 381706 - Documentation: The description of the keyboard shortcut for adding custom tags (Ctrl/Cmd+Y) was ambiguous.
- BUG ID 387321 - Read/Write: The Write node's `first part` control did not work expected when `write full layer names` was enabled.
- BUG ID 387705 - Timeline Viewer: Moving I/O points in the Viewer frame slider did not display a preview pane as expected.
- BUG ID 388199 - macOS only: Launching Nuke Assist enabled the Frame Server incorrectly.
- BUG ID 388840 - Roto/RotoPaint: Creating roto shapes in the Viewer disabled keyboard shortcuts.
• BUG ID 390486 - Read/Write: Opening multiple projects while elements were still loading caused Nuke Studio to crash.
• BUG ID 392256 - macOS only: Reading non-Sony .mxf files displayed the Sony SDK version in the Properties panel.
• BUG ID 392523 - UI: The Viewer selection mode dropdown did not include a tooltip.
• BUG ID 400432- Read/Write: The Advanced > write nclc control in the Write node’s Properties panel did not work as expected with .mov files written using the H264 codec.

New Known Issues Specific to Nuke 11.3

This section covers new known issues and gives workarounds for them, where appropriate.
• BUG ID 392942 - macOS only: The out of range warnings are currently always active in Nuke’s scopes.
• BUG ID 374580 - Linux only: Switching between workspaces with OpenGL Stereo and other modes active in the Viewer occasionally causes Nuke Studio to crash.
• BUG ID 366048 - Linux only: Heavy Particles simulations occasionally display the OS not responding error dialog.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/113/ndkdevguide/appendix/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>11.0v1 to 11.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>11.0v1 to 11.2v1</td>
<td>API</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke’s node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
Bug Fixes

- BUG ID 334610 - Linux only: Calling `import nuke` caused the Python interpreter shipped with Nuke to hang on exit.
Release Notes for Nuke and Hiero 11.3v4

Copyright © 2019 The Foundry Visionmongers Ltd.

Release Date
02 May 2019

Qualified Operating Systems
• macOS High Sierra (10.13) or macOS Mojave (10.14)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration
If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA
An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

Note: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.

On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don’t have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

Note: Other AMD GPUs may work, but have not been fully tested.

On Mac, AMD GPUs are supported on any Mac Pro running Mac OS X Mavericks (10.9.3), mid 2015 MacBook Pros onward, and late 2017 iMac Pros. Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

Warning: Although AMD GPUs are enabled on Mac Pros manufactured prior to the late 2013 model, they are not officially supported and used at your own risk.

Multi-GPU Processing

Nuke’s GPU support includes an Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD FirePro W9100s.
New Features

There are no new features in this release.

Feature Enhancements

Deep

The DeepHoldout and DeepMerge nodes now include a compute occluded samples control. When enabled, the values of samples from main are affected by the occlusion values of the holdout samples in front of them. When disabled, holdout occlusion is ignored.

For example:

<table>
<thead>
<tr>
<th>Depth</th>
<th>0</th>
<th>H0</th>
<th>H1</th>
<th>H2</th>
<th>M2</th>
<th>H3</th>
<th>M4</th>
</tr>
</thead>
</table>

M = main sample
H = holdout sample

M0 remains unchanged since there are no holdout samples before it. M2 is affected by the combined H0, H1, and H2 holdout samples and M4 is affected by all holdout samples.

Additionally, the DeepMerge drop zero threshold control is now included in DeepHoldout, allowing you to filter out samples whose alpha value falls below this threshold, such as those caused by floating point inaccuracy.

Bug Fixes

- BUG ID 320261 - Linux only: GPU accelerated Convolve2 nodes in some customer scripts printed Error: filter input is missing rgba in the Viewer.
- BUG ID 322910 - Deep: DeepMerge nodes set to holdout produced a less accurate result when compared to DeepHoldout nodes.
- BUG ID 324076 - DeepHoldout: Alpha occlusions did not holdout correctly.
- BUG ID 376892 - DeepMerge: Setting operation to holdout combined alpha values if the B input was semi-transparent and behind the A input.
- BUG ID 386217 - LensDistortion: Adding a LensDistortion2 node to the Node Graph displayed a Warning: enumeration index value cannot be converted to int for item Lanczos4 message on the command line.
- BUG ID 389350 - Linux only: Reading in .mxf files displayed a GLIBC_2.14 not found error.
• BUG ID 390303 - Deep: The knob names and tooltips for the DeepHoldout and DeepMerge nodes were misleading.

New Known Issues Specific to Nuke 11.3

This section covers new known issues and gives workarounds for them, where appropriate.
• BUG ID 376534 - Timeline Multi-View: Switching to and from the timeline Viewer OpenGL Stereo mode causes playback to pause. Press play to resume playback.
• BUG ID 366048 - Linux only: Heavy Particles simulations occasionally display the OS not responding error dialog.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/113/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>11.0v1 to 11.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>11.0v1 to 11.2v1</td>
<td>API</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke’s node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")

New Features

- BUG ID 380807 - Python: You can now set node icons in the Node Graph Pythonically using the setCustomIcon() function.

Feature Enhancements

There are no feature enhancements in this release.
Bug Fixes

• BUG ID 378856 - Python: Setting the default value knob `Root.views()` in the `init.py` file did not work as expected.
• BUG ID 387422 - Documentation: The `ParallelFor` API was not documented in the Nuke NDK documentation.
Release Notes for Nuke and Hiero 11.3v3

Copyright © 2019 The Foundry Visionmongers Ltd.

Release Date

21 March 2019

Qualified Operating Systems

• macOS High Sierra (10.13) or macOS Mojave (10.14)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

Note: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don’t have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

**Note:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

**Note:** Other AMD GPUs may work, but have not been fully tested.

• On Mac, AMD GPUs are supported on any Mac Pro running Mac OS X Mavericks (10.9.3), mid 2015 MacBook Pros onward, and late 2017 iMac Pros. Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

**Warning:** Although AMD GPUs are enabled on Mac Pros manufactured prior to the late 2013 model, they are not officially supported and used at your own risk.

Multi-GPU Processing

Nuke’s GPU support includes an Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

**Note:** Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD FirePro W9100s.
New Features

Nuke, Nuke Studio, and Hiero Viewers now include an OpenGL Stereo mode which allows you to see both views at once on a 3D monitor for review purposes.

Note: OpenGL Stereo mode is not available on Mac due to limitations in macOS.

For more information, see Previewing Stereoscopic Images for Nuke and Displaying Views in the Viewer for Nuke Studio and Hiero.

Feature Enhancements

The Nuke User Guide and Node Reference Guide are now available to download as PDFs from https://learn.foundry.com under PDF Documentation.

Bug Fixes

- **BUG ID 155998** - UI: Layouts spanning two monitors were not display correctly on reload.
- **BUG ID 159131/198430** - Windows only: Sony F55 .mxf files on external drives could not be read if there was a space in a directory name.
- **BUG ID 270870** - LensDistortion: Undistort and Redistort produced poor results compared to STMap warps.
- **BUG ID 275171** - Export: The Burn-in gizmo only displayed correct clip information for the first clip on each track.
- **BUG ID 357615** - Linux only: Dragging and dropping URL-based data into the Node Graph caused a double callback of the function.
- **BUG ID 367451** - VectorDistort: GPU settings were unavailable with a vanilla Nuke license.
- **BUG ID 369832** - VectorCornerPin: Pressing Shift during a manual transform in the Viewer caused the handles to behave erratically.
- **BUG ID 370233** - VectorCornerPin: Adjusting controls in the Properties panel did not always update the transform handles' bounding box.
- **BUG ID 370683** - VectorCornerPin: The Keys tooltip in the Properties panel was incorrect.
- **BUG ID 370847** - VectorCornerPin: Adding a keyframe with no SmartVector input caused Nuke to crash.
- **BUG ID 372904** -
- **BUG ID 373955** - VectorCornerPin: CUDA memory allocation errors were occasionally displayed during playback between keyframes.
- **BUG ID 373956** - SmartVector: Computing SmartVectors in conjunction with VectorCornerPin was slow.
- BUG ID 374174 - VectorCornerPin: The Copy From, Copy To, and Set to Input knobs in the Properties panel did not support drag-and-drop editing.
- BUG ID 374224 - VectorCornerPin: The internal vector cache was overwriting itself incorrectly.
- BUG ID 374418 - VectorCornerPin: Opening or closing a group knob in the Properties panel erased cached vectors between user keyframes.
- BUG ID 374916 - VectorCornerPin: The Properties panel tooltips were out of date.
- BUG ID 374922 - VectorCornerPin: Setting the Viewer proxy to a value less than 1:1 caused the source image to disappear.
- BUG ID 375186 - ARRIRAW: The Read node's Look Editor controls were incorrectly exposed by default.
- BUG ID 375792 - VectorCornerPin: Changing the SmartVector input did not reset the auto-calculated to Viewer widgets.
- BUG ID 375846 - Linux and Windows only: AMD GPUs did not display an image in Nuke Studio's timeline Viewer.
- BUG ID 375904 - VectorCornerPin: Setting the Viewer proxy to a value less than 1:1 with pre-rendered SmartVectors did not work as expected.
- BUG ID 375935 - LensDistortion: Marquee select did not work as expected on links in the Viewer.
- BUG ID 376019 - Timeline Multi-view: The view buttons did not update correctly from single view to other stereo modes.
- BUG ID 376045 - ARRIRAW: Dropping files with more than one period in the file name from the Project panel to the Node Graph displayed a temporary error on the Read node.
- BUG ID 376078 - CameraTracker: Clicking Update Track or Update Solve in the Properties panel displayed a 'Node' object is not iterable error.
- BUG ID 376342 - LiveGroup: Override knobs from 3D nodes, such as TransformGeo, were locked when LiveGroups were published.
- BUG ID 376529 - Timeline Multi-View: Changing the views in a project with a floating monitor output window open caused Nuke Studio to crash.
- BUG ID 378078 - Windows 10 Pro for Workstations only: Reading certain .mxf files displayed The specified module could not be found - mxfReader.dll in the Viewer.
- BUG ID 378716 - Timeline Multi-View: Views specified in template scripts were incorrectly overridden by the Preferences > Project Defaults > Views options.
- BUG ID 379724 - Timeline Multi-View: Certain soft effects did not work as expected in stereo projects containing blended tracks.
- BUG ID 379823 - Timeline Multi-View: Splitting knobs per view did not work as expected for the Crop soft effect.
- BUG ID 380449 - VectorDistort: Setting the Viewer proxy to a value less than 1:1 with pre-rendered SmartVectors did not work as expected.
- BUG ID 381688 - Timeline Multi-View: Versioning up a clip changed the file path from an image sequence, such as example.%04d.dpx, to a single frame file path.
- BUG ID 381704 - Versioning: Changing the version of a clip with different frame ranges per version did not work as expected.
- BUG ID 383218 - DeepHoldout: Certain Deep .exr images connected to the holdout input caused Nuke to crash.
• BUG ID 383268 - LensDistortion: The Filter dropdown options did not map correctly to the options in legacy scripts.
• BUG ID 383779 - Versioning: Scanning for versions on clip that relied on a remapped OS path in the Preferences did not work as expected.

New Known Issues Specific to Nuke 11.3

This section covers new known issues and gives workarounds for them, where appropriate.

• BUG ID 386217 - LensDistortion: Adding a LensDistortion2 node to the Node Graph displays a Warning: enumeration index value cannot be converted to int for item Lanczos4 message on the command line. This message does not affect operation and can be ignored.
• BUG ID 376534 - Timeline Multi-View: Switching to and from the timeline Viewer OpenGL Stereo mode causes playback to pause. Press play to resume playback.
• BUG ID 366048 - Linux only: Running heavy Particles simulations occasionally display the OS not responding error dialog.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/113/ndkdevguide/appendix/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>10.0v1 to 10.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>10.0v1 to 10.5v1</td>
<td>API</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke’s node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescrptes/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

- BUG ID 380355/380361 - Python: Calling hiero.ui.openInViewer() caused Nuke Studio to crash.
• BUG ID 381050 - Python: Adding a custom menu to the **Properties** panel did not work as expected.
Release Notes for Nuke and Hiero 11.3v2

Copyright © 2019 The Foundry Visionmongers Ltd.

Release Date

07 February 2019

Qualified Operating Systems

• macOS High Sierra (10.13) or macOS Mojave (10.14)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

Note: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don’t have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

![Note: We recommend using the latest graphics drivers, where possible, regardless of operating system.]

### AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

![Note: Other AMD GPUs may work, but have not been fully tested.]

• On Mac, AMD GPUs are supported on any Mac Pro running Mac OS X Mavericks (10.9.3), mid 2015 MacBook Pros onward, and late 2017 iMac Pros. Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

![Warning: Although AMD GPUs are enabled on Mac Pros manufactured prior to the late 2013 model, they are not officially supported and used at your own risk.]

### Multi-GPU Processing

Nuke’s GPU support includes an **Enable multi-GPU support** option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

![Note: Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD FirePro W9100s.]
New Features

There are no new features in this release.

Feature Enhancements

• BUG ID 375738/379636 - R3D SDK: The HDR2084 gamma curve was incorrect and has been superseded by a new st2084 curve.
• BUG ID 377230 - Particles: Details of the Particle Performance API improvements have been added to the Nuke NDK Development Guide.
• BUG ID 378349 - AMD GPUs are now enabled on Mac Pros manufactured prior to the late 2013 model, but they are not officially supported and are used at your own risk.

Bug Fixes

• BUG ID 155871 - ParticleDrag: The steps per frame control in the ParticleSettings node was not taken into account when applying drag. For example, with 10 steps per frame, the drag factor was applied 10 times in the full frame. This resulted in far slower particles than in the original script.
• BUG ID 182027 - Export: Manually typing values into float sliders inserted .0 into the value.
• BUG ID 200229 - SmartVectors: Canceling a write operation in the SmartVector node displayed a misleading error message or caused Nuke to become unresponsive.
• BUG ID 238890 - Write: Rendering multiple views using OCIO color management produced inconsistent colorspace values between views.
• BUG ID 270934 - Timeline Disk Caching: Caching sequences containing gaps in the timeline did not update the cache button correctly.
• BUG ID 361048 - Node Graph: Saving and clearing scripts containing cloned nodes caused Nuke to crash.
• BUG ID 361176 - Export: Shot referring to transcoded clips as the image source in the Export dialog displayed an error on export.
• BUG ID 365600 - Sony SDK: Reading in certain .mxf files displayed a warning message on the command line.
• BUG ID 366511 - Particles: Caching certain heavy simulations was slower than in previous versions of Nuke.
• BUG ID 367089 - ARRIRAW: Dragging certain .ari files into the Node Graph momentarily showed an error on the Read node.
• BUG ID 369203 - Sony SDK: Certain .mxf files did not playback as expected due to decoding errors.
• BUG ID 372273 - LiveGroups: Knobs exposed on a locked, child LiveGroup were not locked when the parent LiveGroup was published.
• BUG ID 373055 - Channel Management: Loading a script that exceeded the channel limit caused all Read nodes in the script to display an error.
• BUG ID 373170 - Sony SDK: Setting the Gamut control to Rec709 did not match the Colorspace node's sRGB output.
• BUG ID 373222 - Timeline Caching: Certain interface components did not update correctly when the Clip Reformat option was changed.
• **BUG ID 373227** - LiveGroups: Undoing edits to a LiveGroup did not return the group's state to editable.

• **BUG ID 373429** - Multi-View Timelines: The view order was reversed when the Viewer was set to Squeezed Above Below.

• **BUG ID 373458** - Sony SDK: Undoing changes to certain Read node controls displayed an error.

• **BUG ID 373543** - Colorspace: S-Log2 expected IRE range data which was inconsistent with S-Log1 and S-Log3.

• **BUG ID 373862** - ARRIRAW: Loading a legacy script automatically set Read node’s Processing > Sharpness knobs to 0, but did not display a warning.

• **BUG ID 374142** - macOS only: Cloning certain custom knobs using Shift and drag-and-drop did not work as expected.

• **BUG ID 374767** - LiveGroups: The knob override popup did not always behave predictably.

• **BUG ID 375568** - LiveGroups: Keyed knobs exposed on LiveGroups were loaded as overrides incorrectly.

• **BUG ID 376623** - Soft Effects: Setting a Timewarp effect to Predefined > Reverse in the Curve Editor's right-click menu displayed an error.

• **BUG ID 377901** - ARRIRAW: The playback cache always cached frames at full resolution, despite the Viewer settings.

• **BUG ID 378060** - LiveGroups: Displaying a dialog when running Nuke in terminal mode using the -t command line flag caused Nuke to crash.

• **BUG ID 379243** - ARRIRAW: The st2084 LUT multiplied shots with soft effects incorrectly.

• **BUG ID 380082** - Opening certain legacy projects caused Nuke Studio to crash.

### New Known Issues Specific to Nuke 11.3

This section covers new known issues and gives workarounds for them, where appropriate.

• **BUG ID 376045** - ARRIRAW: Dropping files with more than one period in the file name from the Project panel to the Node Graph displays a temporary error on the Read node.

• **BUG ID 374982** - Windows only: LiveGroups knob override indicators don’t display or update immediately in the Properties panel.

• **BUG ID 373072** - Sony SDK: Setting Resolution to Eighth displayed dead pixels in the Viewer for certain clips.

• **BUG ID 366048** - Linux only: Running heavy Particles simulations occasionally display the OS not responding error dialog.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/113/ndkdevguide/appendix/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>10.0v1 to 10.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>10.0v1 to 10.5v1</td>
<td>API</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

- **BUG ID 374902** - LiveGroups: The node.makeEditable() function did not have a visible return value.
Release Notes for Nuke and Hiero 11.3v1

Copyright © 2019 The Foundry Visionmongers Ltd.

Release Date
13 December 2018

Qualified Operating Systems
• macOS Sierra (10.12) or macOS High Sierra (10.13)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration
If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

Note: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don’t have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

**Note:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

### AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

**Note:** Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

### Multi-GPU Processing

Nuke's GPU support includes an **Enable multi-GPU support** option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

**Note:** Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD FirePro W9100s.
New Features

ARRI SDK Update

ARRIRAW has been updated to version 6, including various improvements and bug fixes that have introduced subtle image differences that are within tolerance. The Read node’s Properties panel includes the following changes:

- The sharpness control now ranges from -5.0 to 5.0. Legacy scripts using the previous 0 to 100 range are remapped to [0,5] when opened.
- A new detail control.

Note: The ARRI look settings are not currently supported.

The full ARRI SDK release notes are publicly available from:
http://www.arri.com/support/downloads/searchable_downloads/

Bounding Box Improvements

Node Graph indications have been added to show changes in bounding box size. You can now tell at a glance the state of the bounding box, even when the Viewer is zoomed in.

The new indications are:

- **red rectangle with dotted stroke** - the indicated node creates a bounding box greater than the format.
- **dotted stroke without the red rectangle** - the bounding box size is greater than the format at the indicated node, but the bounding box size has been set by an upstream node.

You can enable and disable these indicators, set a threshold for the warning, and choose the color of the rectangle in the Preferences.

See Bounding Box Warnings for more information.

Channel Limit Warning

We’ve added a new warning in Nuke’s GUI to tell you when you’re approaching or exceeding the 1023 uniquely-named channel limit in Nuke.

You can set a channel count threshold in the Preferences > Project Defaults > Channel Management, and Nuke warns you when a newly created node causes you to exceed that threshold. Additionally, the currently used channel count is displayed in the status bar - color coded to identify if you’re below the threshold, above the threshold, or above the maximum channel limit.

See Channels for more information.
eGPU Support

Support has been added for AMD cards in eGPU set-ups for macOS 10.13.5 (High Sierra), and later. The Sonnet eGFX Breakaway box and BlackMagic eGPU have been tested.

Live Groups - Locking and Overrides

Locking

In previous versions of Nuke, a published LiveGroup could be made editable by any change to the LiveGroup script or various changes to the parent LiveGroup node.

Now, once a LiveGroup is published, its contents are locked. This means that any action that could modify the script is disabled. Nodes and their inputs/outputs are locked in position, node property panel controls are grayed out and a padlock icon is displayed on the Node Graph tab for that LiveGroup. To unlock a LiveGroup, click Make Editable.

See Editing and Publishing LiveGroups for more information.

Overrides

Live Group overrides build on the existing functionality, taking the workflow a step further by allowing knobs at the level above to act as overrides rather than modifying the knobs inside the LiveGroup script.

Override knob values replace those beneath them in the Live Group hierarchy without changing the original value in the LiveGroup script. Override knobs are marked with yellow squares in the Properties panel.

See Overriding LiveGroup Controls for more information.

Python Callbacks

The Python API for LiveGroups has been extended to include a number of new callbacks, all of which support a return value (True by default). This enables you to control the LiveGroup workflow based on user defined criteria. The Python tab has been removed from the LiveGroup properties.

The callbacks are as follows:

nuke.LIVEGROUP_CALLBACK_CAN_PUBLISH
nuke.LIVEGROUP_CALLBACK_PUBLISHED
nuke.LIVEGROUP_CALLBACK_CAN_MAKE_EDITABLE
nuke.LIVEGROUP_CALLBACK_MAKE_EDITABLE
nuke.LIVEGROUP_CALLBACK_RELOADED
nuke.PRECOMP_CALLBACK_RELOADED
nuke.PRECOMP_CALLBACK_OPENED
Particles Performance Improvements

The Particle system has been optimized to produce up to 6x faster particle simulations and 4x faster playback of particles in the Viewer. In our internal tests, improvements are seen at any scale, with more improvement in simulations with a higher number of particles.

These improvements are a rewrite of some of Nuke’s core particle code, and may result in some differences in output from previous versions of Nuke:

- **BUG ID 133272 - ParticleSpawn:** The `transfer velocity` control’s math was incorrect and produced unexpected results. This change may break backward compatibility with legacy scripts.

- **BUG ID 370706 - ParticleExpression:** Age values for particles created between the first and second frame of a simulation were clamped at the first frame, resulting in incorrect ages for some particles when expressions were applied. This change may break backward compatibility with legacy scripts.

For custom Particle plug-in developers, you can take advantage of new `ParticleSystem` class accessor methods, which return pointers to attribute arrays. Using these is much faster than calling the individual methods for each particle. See Nuke’s NDK Development Guide for more information.

Smart Vector Toolset Improvements

A new node, VectorCornerPin, has been added to the Smart Vector Toolset in NukeX. Using the VectorCornerPin can reduce the need to create multiple VectorDistort nodes with different reference frames and mix between them.

VectorCornerPin uses SmartVector to warp a corner-pinned image between keyframes. You can set keyframes using **User** and **From** controls, just like in the CornerPin node, causing the Source image to warp according to the additional SmartVector input.

See *Warping Images Using VectorCornerPin* for more information.

Sony SDK Update

Sony SDK has been updated to version 3.1, adding support for the Sony VENICE camera, and X-OCN encoded footage from the F5, F55, and VENICE.

Timeline Multiview Support

In addition to multi-view formats such as .exr and .sxf, Nuke Studio, Hiero, and HieroPlayer now allow you to define views using separate files on a single track item, similar to Nuke’s Node Graph %V Read functionality. For example, if you read in `image.left.dpx` and change the name to `image.%V.dpx`, both `image.left.dpx` and `image.right.dpx` are read using the same Read node, provided that views called **left** and **right** exist in your Project Settings.
Tracks can display all views or any single view using the view button, allowing you to set up stereo and VR timelines for review. Once tracks are set, you can use the new export structure to create Nuke scripts with stereo setups for compositing.

See Stereoscopic and Multi-View Projects for more information.

**Viewer Selection Modes**

The selection tool has been improved in both 3D and 2D views, including new modes. You can now select areas of a certain shape with the marquee tools or use the lasso tool to make a selection by tracing the edges of any shape. Additional hotkeys have been added, allowing you to draw a rectangular/ellipse selection from the center and constrain it to square or circle.

Selection area behavior matches Roto/RotoPaint in that, when you hold Shift to add selections, the square/ellipse bbox is anchored at the initial click point with a side length of the Y axis delta.

See Selection Modes for more information.

**Note:** The Viewer properties viewerSelectorMode control can be accessed Pythonically by knob index.

**Feature Enhancements**

- **BUG ID 343648** - Documentation: The Nuke help now includes a supported camera formats page.

**Bug Fixes**

- **BUG ID 154598** - MXF: Setting debayer quality to High Quality on some Sony RAW files displayed an error decoding frame message in the Comp Viewer.
- **BUG ID 176742** - SmartDistort: Error messages during input connection were misleading.
- **BUG ID 235679** - NDK Documentation: The documentation stated incorrectly that the GeoInfo::copy() function copies primitive data.
- **BUG ID 272897** - Timeline Disk Caching: Caching continued after closing the project associated with the frames being cached.
- **BUG ID 277342** - LiveGroups: Undoing a change to a node knob inside a LiveGroup didn't work as expected.
- **BUG ID 304664** - Timeline Disk Caching: The sequence Properties > Clip Reformat options did not work as expected when Timeline Disk Caching was enabled.
- **BUG ID 308870** - Licensing: Nuke 11.0v2 created client floating license files with incorrect names.
- **BUG ID 324685** - Denoise: Various controls in the Properties panel did not work as expected.
- **BUG ID 328102** - Write: Reloading a script incorrectly enabled the check file matches input option in .exr Write node Properties.
- **BUG ID 329048** - ARRIRAW: Undoing changes to Read Properties settings displayed an error in the Viewer.
• BUG ID 329252 - ARRIRAW: Setting an incorrect Debayer Mode in Nuke Studio did not display an error.
• BUG ID 350887 - VectorDistort: Error reporting was unclear when attempting to calculate vectors for a single frame.
• BUG ID 353546 - Denoise: Setting Source to Digital did not work as expected for all input resolutions.
• BUG ID 354345 - Monitor Output: Realtime playback on the timeline was not possible when the output resolution was set to 2160p30.
• BUG ID 358899 - R3D: In legacy mode, the default colorspace was not read from the .rmd metadata.
• BUG ID 358988 - DnD: Drag-and-drop functionality did not work as expected on the Project Settings panel.
• BUG ID 359553 - Stereo: Changing the order of views in the Project Settings changed the hero view in the Compositing environment.
• BUG ID 359747 - Soft Effects: Certain BlinkScript kernels caused Nuke Studio to become unresponsive.
• BUG ID 361673 - LiveGroups: Python exceptions were displayed incorrectly for some functions.
• BUG ID 361843 - Localization: Undoing actions during localization did not work as expected.
• BUG ID 362147 - Bounding Box Warning: Setting the threshold to 0% caused the warning to behave erratically.
• BUG ID 362683 - LiveGroups: Expression links within LiveGroups occasionally produced corrupt files when the script was saved.
• BUG ID 362885 - LensDistortion: Certain scripts exhibited slow render times and lag.
• BUG ID 362908 - Write: Enabling read file in the Properties occasionally reset the file type control.
• BUG ID 363903 - LiveGroups: Overrides on exposed knobs did not work as expected inside nested LiveGroups.
• BUG ID 363967 - Denoise: Setting the Output control to Noise produced unexpected results.
• BUG ID 329061/364388 - ARRIRAW/MXF: Undoing or re-doing changes to a shot did not update the Properties panel.
• BUG ID 365089 - LiveGroups: Copying and pasting an editable, but unmodified LiveGroup created an edited LiveGroup.
• BUG ID 365096 - LiveGroups: Publishing an editable, but unmodified LiveGroup created an edited LiveGroup on reload.
• BUG ID 365102 - Windows only: Reading files with spaces in the file path did not work as expected.
• BUG ID 365190 - MXF: Changing controls in the Properties panel did not always update the Viewer correctly.
• BUG ID 365567 - MXF: Exporting .mxf sequences as .mov files using Process as Sequence produced frame offsets.
• BUG ID 365712 - Export: Spurious knob value warnings were displayed on certain export tasks.
• BUG ID 365863 - MXF: Reading or importing Venice Raw SQ files did not work as expected.
• BUG ID 366072 - LiveGroups: Invisible knobs were not ignored by the override functionality.
• BUG ID 366263 - LensDistortion: Loading a script created a larger bounding box than expected.
• BUG ID 366574 - Denoise: Nuke script precision was changed incorrectly to use Scientific Notation downstream of Denoise nodes.
• BUG ID 366697 - LiveGroups: Reloading a LiveGroup and then enabling an output node in the advanced controls published the LiveGroup incorrectly.
• BUG ID 366872/369082 - ARRIRAW: Clicking load settings from metadata in the Properties panel destroyed the undo stack.
• BUG ID 367591 - Particles: Output from a certain Particles system appeared to bounce incorrectly.
• BUG ID 359974/359983/368716 - Timeline Multiview: Stereo output set to display both eyes or side by side did not display correctly on SDI monitors.
• BUG ID 368743 - Channel Management: Reading clips that broke the channel limit followed by clips that didn’t break the limit occasionally caused Nuke to crash.
• BUG ID 368883 - MXF: Copy and pasting Read nodes did not copy the knob values correctly.
• BUG ID 368915 - LiveGroup: Entering an invalid file path and then undoing the action placed the LiveGroup into the editable state, but the padlock icon was still displayed on the LiveGroup tab.
• BUG ID 369083 - Sony SDK: Selecting the unsupported SGamut in the Read properties did not display an error.
• BUG ID 369425 - MXF: Metadata for some key pairs did not display the correct values.
• BUG ID 369510 - Sony SDK: Editing comps containing certain .mxf files caused Nuke Studio to crash.
• BUG ID 369749 - Mac OS X/macOS only: Exporting multi-view timelines to the .exr format displayed an error unnecessarily.
• BUG ID 369787 - R3D: Clicking Load Settings from RMD in the Properties panel destroyed the undo stack.
• BUG ID 369899 - LiveGroups: Knobs that can add/remove other knobs, such as the Read node’s File knob, could still modify the Properties panel in locked scripts.
• BUG ID 370124 - Mac OS X/macOS only: The monitor output Side by Side mode did not play back as expected.
• BUG ID 370360 - LiveGroups: Right-clicking a published LiveGroup’s Properties panel and selecting Set knobs to default set the LiveGroup’s state to editable.
• BUG ID 370392 - ARRIRAW: Tooltips did not include information on other file types, such as the .mxf extension.
• BUG ID 370395 - Viewer Selection Modes: making selections using different modes did not update in the Viewer in real time.
• BUG ID 370415 - ARRIRAW: Selecting the Debayer Mode incorrectly did not display a clear error message.
• BUG ID 370501 - ARRIRAW: Setting the Colorspace incorrectly to any of the available Monochrome settings did not display a clear error message.
• BUG ID 370506 - LiveGroups: The padlock icon on the LiveGroup’s sub-graph was not clearly visible.
• BUG ID 370509 - Multi-View Timelines: The Reconnect Media function did not include the detect views option and couldn’t reconnect multi-view clips.
• BUG ID 370512 - LiveGroups: Knobs added to published LiveGroups were not saved with the script.
• BUG ID 370519 - LiveGroups: Making a parent LiveGroup editable enabled the Undo and Redo buttons on child LiveGroup Properties panel.
• BUG ID 370536 - Channel Management: Existing Read nodes in the script displayed an error incorrectly when the Channel Warning Threshold was reached.
• BUG ID 370626 - ARRIRAW: Setting Proxy Playback to Half Size Proxy did not work as expected.
• BUG ID 370645 - ARRIRAW: Enabling the lens squeeze options in legacy scripts caused them to disappear.
• BUG ID 370750 - Multi-View Timelines: Single view tracks below multi-view tracks were not visible when Obey Alpha and See Through Missing Media were enabled.
• BUG ID 371220 - ARRIRAW: The Noise Reduction control was not supported and has been removed.
• BUG ID 371327 - Multi-View Timelines: Double-clicking certain clips caused Nuke Studio to crash.
• BUG ID 371377 - Multi-View Timelines: Localizing stereo clips did not work as expected.
• BUG ID 371428 - Particles: Multiple particle inputs did not render correctly.
• BUG ID 371435 - Multi-View Timelines: Certain multi-view .exr files did not show the hero view on extra tracks.
• BUG ID 371437 - Multi-View Timelines: Clips with invalid views imported with partially filled localization bars in the Project panel.
• BUG ID 371463 - Linux only: The R3D Use CUDA option in the Read Properties panel was disabled.
• BUG ID 371466/371476 - Particles: The P_Fogbox toolset occasionally didn't emit particles correctly.
• BUG ID 371529 - ParticleBounce: The Properties panel included three ParticleBounce tabs.
• BUG ID 371596 - Viewer Selection Modes: Sampling a pixel in the Viewer using Ctrl/Cmd-click disabled Viewer selections in the Gridwarp node.
• BUG ID 371598 - Multi-View Timelines: Exporting certain files attempted to access the Preferences in command line mode and displayed an error.
• BUG ID 371685 - Multi-View Timelines: Switching between mono and stereo setups occasionally caused the Viewer to render black.
• BUG ID 371747 - ARRIRAW: Nuke Studio could not create comps from certain .mxf files.
• BUG ID 371903/371987 - ARRIRAW: Certain combinations of Aspect Ratio, Resolution, and Lens Squeeze displayed an error in the Viewer.
• BUG ID 371926 - LiveGroups: Pressing 1, 2, 3, and so on to add a Viewer to the Node Graph does not work as expected when a Viewer exists in a locked LiveGroup.
• BUG ID 371931 - LiveGroups: Undoing Publish or Make Editable did not return the LiveGroup to its previous state.
• BUG ID 371973 - ARRIRAW: The Aspect Ratio control has been moved above the Resolution control to reflect precedence.
• BUG ID 372286 - LiveGroups: Deleting a custom rgba knob on a LiveGroup created gaps in the Properties panel layout.
• BUG ID 372290 - LiveGroups: Deleting an override knob did not revert the source knob to its original value.
• BUG ID 372422 - LiveGroups: Certain override values were not completely deleted when the associated knob was deleted.
• BUG ID 372466 - LiveGroups: Publishing a deleted LiveGroup Pythonically returned True.
• BUG ID 372496 - Channel Management: Reading certain files that broke the Channel Warning Threshold from the command line displayed Warning: Read1: Cannot assign channel number to channel995 multiple times.
• BUG ID 372620 - Channel Management: The channel threshold warning did not display after executing File > Close Comp or Clear.
• BUG ID 372639 - Channel Management: Reading clips containing more than 1024 channels caused Nuke to crash.
• BUG ID 372672 - Sony SDK: Setting different resolutions for the same file in multiple Read nodes caused Nuke to crash during playback.
• BUG ID 372740 - ARRIRAW: The thumbnails for .ari and .mxf files were not set to their native resolutions.
• BUG ID 372749 - LiveGroups: Deleting overrides on exposed knobs and re-publishing did not lock the LiveGroup.
• BUG ID 372772 - LiveGroups: Nesting a Published LiveGroup inside another LiveGroup and then undoing the action locked the overrides on the published LiveGroup.
• BUG ID 372777 - Sony SDK: Invalid relative resolutions were available when using High Quality debayering.
• BUG ID 372934 - ARRIRAW: The error message displayed for unsupported resolutions in legacy scripts was misleading.
• BUG ID 373011 - ARRIRAW: Certain .ari and .mxf files displayed an error message when read into Nuke.
• BUG ID 373069 - Sony SDK: Scrubbing the playhead while a Read node was updating caused Nuke to crash.
• BUG ID 373242 - ARRIRAW: Legacy controls were not correctly mapped to the new knob name changes.
• BUG ID 373296 - ARRIRAW: Loading legacy scripts unexpectedly changed knob values.
• BUG ID 373375 - Sony SDK: Multiple Read nodes referencing the same file with different control values was not supported.
• BUG ID 373386 - DeepRecolor: Soft edges for different objects in auxiliary channels were not combined correctly when target input alpha was enabled.
• BUG ID 373581/373708 - Multi-View Timelines: Comps were not created correctly when views were in separate clips, rather than from multi-view files such as .exr clips.
• BUG ID 373676 - ARRIRAW: Certain legacy scripts could not be loaded.
• BUG ID 373682 - Channel Management: The Channel Count text in Nuke's interface was the wrong color.
• BUG ID 373684 - Channel Management: The Channel Count in Nuke's interface was clamped to 1024.
• BUG ID 373701 - Multi-View Timelines: Comps were not named correctly when created from separate clips, rather than from multi-view files such as .exr clips.
• BUG ID 373720 - LiveGroups: Modifying a LiveGroup and then undoing the action did not revert the LiveGroup to the editable state.
• BUG ID 373860 - Windows only: The Proxy Playback control was not set correctly with legacy .ari and .mxf files.
• BUG ID 373868 - ARRIRAW: Loading certain scripts displayed a warning.
• BUG ID 373897 - ARRIRAW: Right-clicking on a sequence with the Properties panel open for .ari and .mxf shots caused Nuke Studio to crash.
• BUG ID 373992 - LiveGroup: Applying overrides to exposed knobs did not update the LiveGroup state icon in the Node Graph correctly.
• BUG ID 374109 - LiveGroups: Undoing a Make Editable action was not registering as an individual undo in the stack.
• BUG ID 374259 - Channel Management: The info bar at the bottom-right of the Hiero interface was not displayed correctly and errors were printed on the command line.
• BUG ID 374628 - ParticleWind: The steps per frame control in the ParticleSettings node was not taken into account when applying wind.
• BUG ID 375178 - R3D: Switching the Image Pipeline from legacy to IPP2 mode did not display all the available options.
• BUG ID 375204 - Soft Effects: Hidden knobs were exposed incorrectly on certain effects’ Properties panels.
• BUG ID 375909 - Windows only: Reloading a LiveGroup displayed a LiveGroupInfo: Unknown command message.
• BUG ID 375928 - Export: Transcoding audio shots from multi-view sequences did not work as expected.
New Known Issues Specific to Nuke 11.3

This section covers new known issues and gives workarounds for them, where appropriate.

- BUG ID 376045 - ARRIRAW: Dropping files with more than one period in the file name from the Project panel to the Node Graph displays a temporary error on the Read node.
- BUG ID 374982 - Windows only: LiveGroups knob override indicators don’t display or update immediately in the Properties panel.
- BUG ID 374142 - macOS only: Cloning certain custom knobs using Shift and drag-and-drop did not work as expected.
- BUG ID 373227 - LiveGroups: Undoing edits to a LiveGroup does not return the group’s state to editable.
- BUG ID 373222 - Timeline Caching: Certain interface components did not update correctly when the Clip Reformat option was changed.
- BUG ID 373170 - Sony SDK: Setting the Gamut control to Rec709 did not match the Colorspace node’s sRGB output.
- BUG ID 373072 - Sony SDK: Setting Resolution to Eighth displayed dead pixels in the Viewer for certain clips.
- BUG ID 369203 - Sony 3.1: Certain .mxf files do not playback as expected due to decoding errors.
- BUG ID 367089 - ARRIRAW - Dragging certain .ari files into the Node Graph momentarily shows an error on the Read node.
- BUG ID 366511 - Particles: Caching certain heavy simulations may be slower than previous versions of Nuke.
- BUG ID 366048 Linux only: Running heavy Particles simulations occasionally display the OS not responding error dialog.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/113/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>10.0v1 to 10.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>10.0v1 to 10.5v1</td>
<td>API</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke’s node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

- **BUG ID 374043 - NDK Documentation:** A new method, KnobChangedObserver, has been added enabling a knob or op to watch for knob changes in other nodes.
Bug Fixes

• BUG ID 359072 - Python: The API function `openInTimeline()` did not display the track view icon correctly.
• BUG ID 360592 - LiveGroups: Publishing a LiveGroup Pythonically without a valid `file` path threw an exception.
• BUG ID 364627 - Python: Calling `nuke.thisClass()` occasionally caused Nuke to crash.
• BUG ID 371058 - Multi-View Timelines: Python exports did not recognize path substitutions in the Preferences.